User Manual
For the new 2016 Qmini Spectrometer
Version: 2.0.3
Date: October 6th, 2016

This document is protected by copyright. Do not copy or publish this document or parts of it without written permission of RGB Photonics GmbH.

Product specifications and descriptions in this manual are subject to change without notice. RGB Photonics GmbH will not be responsible for errors and omissions in this manual or for direct or incidental damages in connection with the use of this device or information.

© 2016 RGB Photonics GmbH
Donaupark 13
93309 Kelheim
Germany
Telephone:  +49 9441 1750 33 – 0
Website:  http://www.rgb-photonics.com
E-Mail:  sales@rgb-photonics.com
# Contents

1 Introduction .........................................................................................................................1
   1.1 Product Overview ........................................................................................................1
   1.2 System Requirements ..................................................................................................2
   1.3 Package Contents ........................................................................................................2
   1.4 Optional Accessories .................................................................................................2

2 Installation ........................................................................................................................3
   2.1 USB interface ...............................................................................................................3
   2.2 UART interface ...........................................................................................................3
   2.3 Optical Setup ...............................................................................................................4
   2.4 Troubleshooting ..........................................................................................................5

3 Operation ..........................................................................................................................6
   3.1 Introduction ................................................................................................................6
   3.2 Overview ......................................................................................................................6
   3.3 Taking Spectra ............................................................................................................7
   3.4 Spectrum Display ......................................................................................................8
   3.5 Working with spectra .................................................................................................9
   3.6 File Operations ........................................................................................................10
   3.7 Spectrum Calculations .............................................................................................11
   3.8 Tools ........................................................................................................................12
   3.9 Absorption, Reflection and Transmission Measurements ....................................13
   3.10 Calibration ...............................................................................................................15
   3.11 Triggering and I/O Port ...........................................................................................18

4 Software Development Kit ..............................................................................................20
   4.1 Prerequisites .............................................................................................................20
   4.2 Getting started .........................................................................................................20
   4.3 Classes Overview ....................................................................................................20
   4.4 Adding the SDK library to your project .................................................................21
   4.5 Taking a spectrum ....................................................................................................22
   4.6 Deploying your project .............................................................................................22

5 Technical Support .............................................................................................................23
   5.1 Getting Help .............................................................................................................23
   5.2 Software Updates ....................................................................................................23

6 Specifications ................................................................................................................24
   6.2 Pin Assignment .........................................................................................................26

7 Certifications and Compliance .........................................................................................28
1 Introduction

1.1 Product Overview

Within an amazingly small design, the Qmini delivers technical specifications that are unprecedented at this size. Its compact design enables tight integration in applications where space is limited, like hand-held analysis devices.

This manual describes the new 2016 version of the Qmini (with the 30-pin auxiliary connector). If you have the previous version, please download the corresponding manual from our website.

Qmini Hardware Features

- Miniature design
- Spectral resolutions starting at 0.3 nm
- Customizable wavelength range, sensitivity and resolution
- Optical input via SMA fiber connector or free focused beam
- 4 I/O channels for external triggering, light source control and general purpose I/O

The new version of the Qmini includes a powerful new electronics board that enables:

- Full processing of spectra in the device
- Averaging and smoothing
- Binning and buffering of spectra
- Complex application-specific evaluation algorithms
- A large choice of available communication interfaces
- A new I/O connector for analog and digital signals

The new Qmini also features a replaceable entrance slit, reduced stray light and lower power consumption.

Waves Software Features

- Take and display series of spectra
- Automatic exposure control with dark spectrum interpolation
- Import most ASCII-based file formats
- Export as ASCII table to almost any numerical analysis software
- Comprehensive tools for displaying and analyzing spectra
- “Strip charts” for comparing characteristic values between multiple spectra including peak follower in real time
- Graph printing and export to PDF
- Dynamic peak finder (no need to set a threshold level)
- Transmission, reflection, absorption and colorimetric measurements
Applications

- Color measurement
- Chemical analysis
- Quality control
- System integration
- Counterfeit detection
- Environmental analysis
- and many more

1.2 System Requirements

- Windows 10, 8, 7, Vista or XP (32 or 64 bit)
- .NET Framework Version 3.5 or 4.0 (available on the CD and as a free download)

1.3 Package Contents

- Qmini spectrometer
- USB data cable
- CD-ROM with Waves spectroscopy software including device driver, software development kit and this manual as PDF
- Printed user manual

1.4 Optional Accessories

- I/O port adapter
- Cosine correcting probe
- SMA collimator
- Fiber optical cable
- More specialized accessories available on request

Visit us at www.rgb-photonics.com if you need any accessories for your spectrometer.
2 Installation

2.1 USB interface

Installing the Qmini spectrometer is very straightforward. You just need to install the software and then connect the device to a USB port.

Please install the software by double-clicking on the WavesSetup.exe file on the CD-ROM. Alternatively, you can also download the latest version from our website. The setup package then installs the application software and the device driver. For the operating system to properly recognize the device, it’s best if you install the software first before attaching the device.

The software is tested with 32 and 64 bit versions of Windows 10, 8.1, 8, 7, Vista and XP. It requires the Microsoft .NET framework version 3.5 or 4.0, which is already installed on most PCs. If this framework is not installed, the setup package asks you to install it first. You can find the setup file for the .NET framework on the CD or download it from the Microsoft website.

You can install the software on as many computers as you like. For example, you may want to install it in the lab for measurements and in your office for further spectrum analysis.

After the software is installed, please connect your Qmini spectrometer to a USB port on the computer. You can use the provided USB cable or almost any other USB Type-C cable. The Qmini does not use USB 3.1 or USB Power Delivery above 500 mA, therefore an active cable is not required. The USB port needs to supply an electrical current of up to 200 mA, so you need to either connect the spectrometer directly to your computer or to an externally powered USB hub.

When you start the Waves software, it automatically searches for spectrometers and, if it finds one, initializes the device. If you attached it just before, it may take a few seconds before the spectrometer is properly recognized by the operating system.

If the software finds no or several spectrometers while starting, it displays a dialog window from which you can choose a device or decide to use a “Simulated spectrometer” instead. This simulated spectrometer can be used to evaluate the software without connecting an actual device. You can access this dialog window later by choosing “Device Setup” from the File menu.

2.2 UART interface

The Qmini can also be controlled with the UART interface that is available on the front side auxiliary connector. This is almost the same as a regular RS-232 interface, but the voltage levels on the data lines are 0 V (low) and +3.3 V (high) instead of the RS-232-
specified positive and negative voltages. This makes it easier to connect the spectrometer to an embedded microcontroller, but if you would like to connect it to a regular RS-232 serial port, you’ll need a special cable with a level shifter. This cable is available as an optional accessory. Please see chapter 6.2 for the pinout of the auxiliary connector.

Even though most users of the UART interface are going to connect the device to their own custom hardware, we recommend that you try to operate the spectrometer using a PC and our application software Waves first in order to get familiar with the device.

To use the Qmini with UART interface with a PC, please use the special level shifter cable and connect it to a serial port on your PC. Because a regular serial port does not provide a supply voltage, you also need an external 5 V DC power supply to power the spectrometer.

When you connect the device to power, the red LED should flash briefly and the green LED should be lit continuously. If the green LED is off, the device probably does not get enough power.

To install the application software Waves, please proceed as described in the previous chapter. When using Waves with the UART interface, please note that there are two differences to the USB version:

- The data transfer is slower. The speed was intentionally reduced to 230400 baud in order to ensure compatibility with most serial port interfaces. If you use your own hardware, you can set the data rate as high as 3 Mbaud.
- In order to open the device connection, you need to uncheck the checkbox “Auto-Scan all ports” and then select the correct COM port.

In order to connect the Qmini with UART interface to your own custom hardware, please refer to the connector pinout in chapter 6.2.

2.3 Optical Setup

The light enters the Qmini spectrometer through a 20 µm slit (other slits are available). You can see this slit if you look into the fiber optical connector on the front side of the device.

If the light you wish to measure is quite strong, you may simply point the spectrometer towards it. For example, you can test the spectrometer by pointing it towards your computer screen or your desk light.

In most cases, however, you’ll need a special optical probe to collect as much light as possible. In order to guide the light from the probe to the spectrometer, most users prefer a simple fiber optical cable with SMA connectors. Alternatively, you may also focus the light directly onto the entrance slit without fibers using your own optics. We recommend standard fiber optical cables with a core diameter of 200 or 400 µm and a small numerical aperture.
**PLEASE NOTE:** The calibration for the spectral sensitivity correction and the optical power was made with a 200 μm fiber optical cable. If you use a different fiber or especially if you just point the spectrometer towards the light source, the measured spectrum might not be accurate. If you have a calibrated light source, you can always recalibrate the spectral sensitivity for any optical setup (see chapter 3.10).

If you focus the light directly onto the entrance slit, you’ll get the best sensitivity and lowest stray light if you try to make sure that:

- The focused light is aligned on the center of the entrance slit,
- the height of the light spot on the entrance slit is 200 μm or smaller and
- the numerical aperture of your focusing optics is close to 0.1, matching the numerical aperture of the spectrometer.

The Qmini spectrometer does not detect light from outside a cone that corresponds to a numerical aperture of about 0.1. Therefore, if your focusing optics has a larger aperture, you lose some light intensity inside the spectrometer.

### 2.4 Troubleshooting

**Both the green and the red LED are lit continuously**

This usually indicates that the device driver is not installed.

**Waves cannot find the device**

Please disconnect and reconnect your spectrometer, close the “Device Config” window, wait a few seconds and open this window again from the File menu. If this doesn't help, please restart your computer and try again.

Please also check our website www.rgb-photonics.com for software updates.

If the software still cannot find the device, you may check the Device Manager in the Windows Control Panel. Your spectrometer should show up as a “Qmini” in the “Measurement and Control” category. If your spectrometer is marked with an exclamation or question mark, please remove the device, uninstall the software from the Windows Control Panel, restart the computer and install the software again.

If your spectrometer is not listed at all in the Device Manager, please try a different USB port. If the device does not work on one computer, but works on others, the USB port may not provide enough power for the spectrometer. In this case, you may have to use an externally powered USB hub.

If this doesn’t help either, please contact our Technical Support Team (see chapter 5.1).
3 Operation

3.1 Introduction

The spectroscopy software Waves was designed from the ground up to provide a clean and straightforward user interface that does not stand in your way, without compromising advanced features or precision.

If you are new to spectroscopy, you’ll find it easy to start using the software and taking spectra without having to worry about details like calibration or dark spectra.

If you already have experience with other spectroscopy software, you’ll notice a few differences:

  * There is just one mode of operation that includes all relevant types of measurements (absorption, irradiance, scope and so on) through a consistent and clear interface.
  * Waves favors a simple self-explanatory terminology instead of complicated terms that need to be explained. For example, we use “Exposure time” instead of “Integration time”, because the average user doesn’t really know what’s being integrated here.
  * There are no wizards to help you with complicated tasks, because wizards tend to conceal the actual task. We believe it’s better to make these tasks accessible through a clear and unified interface, so that you can understand what’s going on.

3.2 Overview

When you start Waves, the software searches for an attached Qmini spectrometer. If it finds one, it automatically initializes it. Afterwards, the software presents the main window:
The main window consists of several panels:

1. The Exposure Toolbar, where you can start and stop taking spectra and set the acquisition parameters.
2. The Spectrum List shows all spectra that are currently in memory.
3. The Properties Panel consists of five tab pages and displays many parameters and values of the spectrum currently selected in the Spectrum List.
4. The Main Diagram Panel shows all spectra from the list that are marked with a check mark.
5. The Display Parameters Panel determines how the spectra are displayed.

In order to get more screen space for the main diagram, the other panels can be minimized by clicking on the buttons with two triangles next to the panel title.

3.3 Taking Spectra

In order to take a spectrum, just choose an exposure time or select auto exposure and click on one of the green buttons (▶) for a single shot or (▶) to start a continuous measurement). You can increase the exposure time in order to decrease the noise level. If the amount of light detected during the exposure is too large for the CCD detector inside the spectrometer, the spectrum appears saturated and a red “OVERLOAD” warning appears at the top of the diagram. In this case, you need to decrease the exposure time. You can further increase the sensitivity by averaging across multiple exposures with the “Averaging” setting.

If a spectrum acquisition takes longer than one second, you can monitor the progress in the status bar at the bottom of the window. The acquisition may finish before the progress indication reaches the end position, because the spectrometer is triggering on the end of the exposure period (see chapter 3.11 for details). You can stop the data acquisition by clicking on the red stop button [■].

If you choose auto exposure, the exposure time for each new spectrum is set automatically based on the intensity of the previous spectrum. It may take a few spectra
before the auto exposure control has reached its optimum. In auto exposure mode, you can set a maximum exposure time in order to prevent very long exposure times in cases when there is simply no signal.

Spectra can be taken with or without spectral sensitivity correction (see chapter 3.10 for more details). If the lightmeter button is selected, the spectral sensitivity of the spectrometer is automatically corrected and the intensity axis is measured in a physical unit like nW/nm.

**PLEASE NOTE:** If you take a spectrum with spectral sensitivity correction, the noise in the spectrum is not evenly distributed, because some parts of the spectrum are more amplified than others. On the other hand, if this button is not selected, the spectral sensitivity is not corrected and the intensity axis displays values as they are produced by the spectrometer hardware. In this case, you may find an uneven distribution of the sensitivity across the spectrum. For precise measurements, it is recommended to turn the spectral sensitivity correction on.

The dark spectrum for the spectrometer sensor is stored in the device and used automatically when taking spectra (see chapter 3.10 for details). If you have background radiation, you can compensate for it by taking a background spectrum (see chapter 3.9). In the Exposure Toolbar you can also select the triggering mode (see chapter 3.11) and choose a reference spectrum for absorption, reflection and transmission spectroscopy (see chapter 3.9).

### 3.4 Spectrum Display

The Main Diagram Panel displays all spectra that are marked by a check mark in the Spectrum List. If no spectrum is checked in the list, the currently selected spectrum (marked by a gray bar) is displayed. You can check and uncheck all spectra at once by clicking on the corresponding button or on top of the Spectrum List.

The peaks in the spectra are automatically determined. This does not only work reliably for clearly defined peaks, but also for those lying in the side of another peak or those that are just above the noise level. If necessary, you can fine-tune the parameters for finding the peaks by choosing “Peak Finder Parameters” from the Tools menu. In this window you can choose three settings:

- “Absolute threshold” determines how much a peak must be above the noise level in order to be considered as a peak.
- “Relative threshold” describes how large a peak must be compared to the local minima before and after it in order to be considered as a peak.
- “Position threshold” determines how much of the top part of the peak is considered when calculating the peak position.

Peak positions and widths are only displayed for the currently selected spectrum. The peak positions, heights and widths are also displayed in the Properties Panel and can be exported by choosing “Export Peaks” from the File menu.
In the Display Parameters Panel below the diagram you can select how the spectra are displayed. These settings affect the diagram display, but do not modify the actual data. Here you can change the scaling of both axes, the unit of the wavelength axis, turn the display of the grid, peak positions and peak heights on and off and see the coordinates of the current position of the mouse pointer.

If you zoom into the wavelength axis, a scrollbar appears at the bottom of the diagram for easily moving the displayed part of the spectrum. Alternatively, you can grab and move the axis with the mouse. You can also drag the intensity axis in order to change the maximum value and quickly enlarge weaker parts of the spectrum.

If you would like to determine the intensity value at the position of the mouse pointer relative to a reference value, just move the mouse to that reference value, click with the right mouse button and choose “Set reference level”.

You can select a single wavelength or a range of wavelengths by clicking or clicking and dragging in the diagram. This selection can be used to compare wavelength values, to display statistical data just for this selection (see chapter 3.5) and to zoom into it (by right-clicking).

### 3.5 Working with spectra

In Waves, you can have several spectra loaded at the same time for easy comparison and analysis. On the upper left side you can see the Spectrum List. Whenever you take a new spectrum, it appears in this list as “current spectrum” and overwrites any previous “current spectrum”. If you would like to keep this spectrum and take another one, just click on the single push pin button [ ]. This prevents the current spectrum from being overwritten. A new spectrum you take is then appended to the list. Giving the “current spectrum” a new name also prevents it from being overwritten. You can also choose to keep all new spectra by selecting the button with multiple push pins [ ] in the Exposure Toolbar.

When you have multiple spectra in the list, one spectrum is always selected (marked by a gray bar). All metadata and additional information for this spectrum is displayed in the Properties Panel on the lower left side. The Properties Panel has five Tab pages:

- **General**: Displays spectrum metadata. “Name” corresponds to the name in the Spectrum List. “User” is automatically set to the current Windows user name, but can be changed. “Sample”, “Light” and “Comments” can be freely edited by the user. You can change the color of the spectrum by clicking on the color box. Please note that “User”, “Sample”, “Light” and “Comments” is the same for all spectra in the list. The “y-axis” property shows the physical quantity and unit that is assigned to the y-axis of the selected spectrum. When you change this unit, Waves tries to convert the data automatically. If this is not possible without further information, a warning is displayed.

- **Values**: Displays statistical values both for the whole spectrum and within the selection (if you have selected a range of wavelengths in the diagram).
- **Color:** Displays the most important colorimetric values. Further details are shown in the Colorimetric Analysis windows (see chapter 3.8). For precise color measurements please also read the section on calibration accuracy in chapter 3.10.
- **Peaks:** Displays peak positions, heights and widths. This list can be saved to a file by choosing “Export Peaks” from the file menu.
- **Data:** Displays a list of all data values of the spectrum.

Some of the values in the Properties Panel are saved when saving the spectrum to a file. The others are recalculated when the spectrum is reloaded.

### 3.6 File Operations

You can save the selected spectrum or the whole Spectrum List using the commands in the File menu. You can also open spectrum files to load them back into Waves for further evaluation (sounds obvious, but surprisingly, many spectroscopy applications don’t even support this).

The default file format for spectra is a simple ASCII table with columns delimited by the TAB character and some header lines containing the metadata. This allows the spectrum files saved by Waves to be read by almost any numerical analysis software like Origin, Excel or Matlab. The default file extension for these files is “.spz”. If you click on a .spz file in Window Explorer, it is opened with the Waves application.

If you take a lot of spectra and would like to save some space on your disk, you can choose to save the data in a compressed format by checking “Save data as compressed zip files” in the Options windows. The saved spectrum file is then a zip archive (still with the “.spz” file extension). To retrieve the spectrum data from this file without using Waves, you can change the file extension to “.zip” and the unpack the file like any other zip archive.

In Waves, you can also open spectrum data files written by other applications, if they are saved as ASCII tables or .csv files. Waves tries its best to automatically determine the file structure and is able to open many different file formats.¹

You can print spectra by choosing “Print” from the file menu. If you choose the page orientation as “Landscape”, the spectrum diagram is printed across the whole page. If you choose “Portrait”, the diagram is printed on the upper half of the page and the lower half shows selected metadata and values.

The printing options are designed for the most common tasks. If you have further specific requirements for printing, you may also decide to export the diagram and then use a graphical design software or word processor for printing.

You can export the diagram either as a bitmap image or as a PDF vector graphic. Both options are available by choosing “Export” from the File menu.

---

¹In case you have a spectrum file written as ASCII data and you are unable to open it in Waves, please contact our Technical Support Team and we’ll see if we can include an import filter for this file format.
After choosing a file name, you can set the height and width of the image and the resolution, if applicable. Please note that the text sizes and line widths are constant. Therefore, if you choose a larger export size, the labels and line widths appear to be smaller.

3.7 Spectrum Calculations

The Modify menu offers several ways to evaluate and modify spectra:

Adjust Offset

This adds a constant value to all data points of the selected spectrum. The software suggests an estimated value for compensating an offset, but you may also choose any other value. You can also choose to adjust the offset for all spectra in the list.

Normalize

This multiplies all data points of the selected spectrum by a constant factor. The default factor is chosen for the maximum value to be scaled to 100. Again, you can also choose to adjust the offset for all spectra in the list.

Differentiate

This differentiates the spectrum with respect to the wavelength.

Apply Smoothing

This substitutes each data point by the average of the surrounding data points. You can choose how many data points to include in the averaging and what algorithm to use, including Savitzky-Golay smoothing. The rectangular smoothing is also known as “Boxcar Averaging”.

Alternatively, you can also turn on smoothing in the display parameters panel below the spectrum diagram. This setting applies only to the way the spectra are displayed and does not change the actual data.

Please note that smoothing makes the data less precise, not more precise. Smoothing does not give you any additional features in the spectrum that were not there before. The main application of smoothing is making a spectrum easier to understand for humans.

Correct Baseline

If your spectrum has several sharp peaks on top of a broad background signal, this feature tries to subtract the background signal. This is especially useful to eliminate the broad fluorescence background in Raman spectra.
Duplicate
This creates a copy of the selected spectrum and may be useful if you would like to modify a spectrum, but also keep the original one.

Arithmetic Operations
This creates a new spectrum by adding, subtracting, multiplying or dividing two spectra.

Add Average Over All/Visible Spectra
This calculates the average spectrum of all spectra in the list (or just the visible ones).

Create New Wavelength Scale
This creates a new wavelength scale based on a given start and end wavelength and a step width and interpolates all spectra accordingly.

3.8 Tools
The Tools menu provides the following items:

Strip Chart
You can use this powerful evaluation tool to display a characteristic property of the spectrum as a function of another property for all spectra in the list. The most common task is to display the temporal evolution of a characteristic value. This window can be kept open while taking new spectra to see the changes as they happen.

In the lower left side of the Strip Chart window, you can choose which values to assign to the x and y axis of the chart. You can choose all numerical values that are displayed in the Properties Panel in the main window. If you want to view the temporal evolution of a value, choose this value for the y axis and either “Number in List” or “Time” for the x axis.

If you choose “Value from name” as x or y axis, the software tries parse the name of each spectrum into a number. So for example, if you have a list of spectra that are named “T = 10.3 °C”, “T = 15.2 °C” and so on and you choose “Value from name”, these temperature value are used for the corresponding axis.

In the Strip Chart diagram, the currently selected spectrum is marked by a slightly larger point. Points corresponding to spectra that are currently not visible in the main window are drawn in a lighter red color.
Loupe
This opens a window with a magnified display of the spectrum around the mouse pointer. It may be used in order to study small features in the spectrum as an alternative to zooming in.

Colorimetric Analysis
This window shows more details colorimetric values than the small panel in the main window. All colorimetric values are calculated according to CIE standards. Please also note that there are several settings in the Options window that are used for calculating colorimetric values, like color spaces and reference functions.

Add Reference Spectra
This allows to show all reference spectra used for colorimetric analysis. You can also add a black body spectrum of a certain temperature.

Peak Width Diagram
This opens a window displaying the widths of the detected peaks (Full width at half maximum).

3.9 Absorption, Reflection and Transmission Measurements

Principle
In absorption, reflection and transmission spectroscopy you direct light from a broadband light source onto a sample. Then you take a spectrum $I(\lambda)$ of the light that is transmitted through or reflected from the sample. In order to get meaningful results that are independent of the light source, you also take a spectrum of the light source $I_0(\lambda)$ without the sample as a reference.

The spectral transmittance $T(\lambda)$ or reflectance is then simply the fraction of transmitted or reflected light:

$$T(\lambda) = \frac{I(\lambda)}{I_0(\lambda)}$$

This formula gives values in the range between 0 and 1. The transmittance is usually written as a percentage. The spectral absorbance $A(\lambda)$ is defined as:

$$A(\lambda) = \log \frac{I_0(\lambda)}{I(\lambda)}$$
Please note that the absorbance is sometimes defined as the base 10 logarithm and sometimes as the natural (base e) logarithm. In Waves, you can choose which logarithm to use.

**Measurement**

In order to measure absorption, reflection or transmission you need to take a reference spectrum of the light source first. If your measurement setup is not in complete darkness, it is also generally recommended to take a background spectrum before the measurement.

To take a background spectrum, turn off the light source, set an appropriate exposure time and click the “Take Background Spectrum” button [Ⅰ] on the Exposure Toolbar. In order to minimize noise, you may also want to use temporal averaging. When you’ve taken a background spectrum, you can select the “Use Background Spectrum” button [Ⅰ]. If you take a spectrum afterwards, the background spectrum is automatically subtracted from the measured spectrum, eliminating unwanted background signals.

To take a reference spectrum for transmission or absorption spectroscopy, turn on the light source again, remove the sample, set an appropriate exposure time and temporal averaging and click the “Take Reference Spectrum” button [Ⅱ]. After selecting the “Use Reference Spectrum” button [Ⅱ], you can take spectra of your sample for measuring absorption or transmission.

To take a reference spectrum for reflection spectroscopy, you need a white reference sample to calibrate the setup for 100% reflection. However, all real-world reference samples have a reflection of less than 100% and an uneven spectral distribution. Therefore, for accurate measurements you also need to supply a reference spectrum for your reference sample. To take a reference spectrum, place the white reference sample where you’ll later place the sample to be measured. Then set an appropriate exposure time and temporal averaging and click the “Take Reference Spectrum” button [Ⅲ]. In the following dialog window, you can also specify a data file that includes a calibrated spectrum of your reference sample. After selecting the “Use Reference Spectrum” button [Ⅲ], you can measure reflectivity spectra.

The y axis of the spectrum now shows the relative intensity of the measured spectrum compared to the reference spectrum. In the “Options” dialog from the File menu you can choose different units for displaying the spectra. You can also later change the y-axis unit in the Properties panel.

If your light source does not cover the full range of the spectrometer, the calculated spectrum may show large amounts of noise outside of the wavelength range of your light source. This is normal and reflects the fact that the measurement has a large uncertainty at these wavelengths.

These measurements are quite sensitive to changes of the sample illumination. If in doubt, you may want to take another reference spectrum to check if it is still valid.
3.10 Calibration

The calibration for the wavelengths, dark spectrum, nonlinearity and spectral sensitivity are stored in the device and loaded automatically during device initialization. So in contrast to almost any other spectroscopy software, you don’t need to worry about taking dark spectra and other calibration parameters, it’s all done automatically.

If the device has been used for a long time or if you need a very precise measurement, you can easily recalibrate the spectrometer with Waves, if you have a suitable light source. Recalibration may also be required if the device temperature is outside of the calibrated temperature range. The device temperature is continuously monitored by the spectrometer and a warning is displayed, if the temperature has changed considerably.

After you have recalibrated the spectrometer, you can always restore the factory calibration in the “Device Configuration” window from the File menu.

Calibration Accuracy

The wavelength calibration is very accurate and changes only little with time or temperature. Therefore, most users won’t ever need to recalibrate the wavelengths. The nonlinearity also hardly changes with time or temperature.

The dark spectrum calibration depends significantly on the temperature and the exposure time. These dependencies is automatically taken into account and compensated, so in most case you don’t need to worry about it. However, if in doubt or if you need as little noise as possible, you can always easily recalibrate the dark spectrum because no calibration light source is required.

The calibration for the spectral sensitivity depends a lot on your optical fiber, your measurement probe and how the light is coupled into the spectrometer. During production of the Qmini spectrometer, we don’t know what your optical setup is going to be. Therefore the factory calibration for the spectral sensitivity and especially the absolute intensity is not to be considered as a precise reference, but rather as a first estimate. If you require precise intensity measurements, you’ll have to recalibrate the sensitivity of the whole system including fiber and probe.

In addition, please note that after changing the exposure time, it takes a few spectra before the CCD sensor inside the spectrometer reaches its new equilibrium. This means that after changing the exposure time, the intensities of the following 5 to 10 spectra may not be as accurate as later measurements. Therefore, for precise measurements we recommend not to use the auto-exposure feature and to set a fixed exposure time instead.

Wavelengths

The mapping of the individual pixels of the spectrum to wavelengths is done using a third-order polynomial. The four coefficients for this function are measured during manufacturing and stored in the device. Usually, this wavelength calibration does not
change. Therefore, in most cases you don't need to recalibrate the wavelengths. However, if the ambient temperature has changed substantially, if the device has been used for a very long time or if you just would like to make sure that the wavelengths are still correct, you can always recalibrate the wavelengths if you have a suitable light source with several sharp atomic emission lines. These wavelength calibration sources are usually low-pressure gas discharge lamps filled with Krypton, Neon, Mercury, Argon or Xenon gas.

To recalibrate, take a spectrum of this light source first. Make sure that the relevant peaks are automatically detected. If not, adjust the “Peak Finder Parameters” in the Tools Menu. Then choose “Calibrate Wavelengths” from the Calibration menu. In the “Light source” combo box select the type of light source used. If you don't find your light source in the list, you need to supply your own calibration lines. In this case, please take a look at the “CalibrationLines xxx.dat” files in the installation folder on your hard drive and create a new similar file containing the spectrum lines of your light source.

After you have selected your light source, click on “Start”. The software tries to match the peaks in the measured spectrum to the given spectrum lines for your light source automatically. If a match has been found, the average deviation is displayed. If the match seems to be successful, it is displayed in green, otherwise in red. If the measured peaks have successfully been identified, you can save the four new wavelength calibration parameters to the device by clicking on the “OK” button.

Dark Spectrum

Inside the Qmini spectrometer, the spectra are detected with a CCD or CMOS line image sensor. Like all image sensors, this sensor detects a small signal even if there is no light entering the spectrometer. This signal depends on the individual pixel, the exposure time and the temperature. In order to obtain a precise measurement with a small noise level, this “Dark Spectrum” must be recorded while no light enters the spectrometer and then subtracted from the actual measurement.

For your Qmini spectrometer, this dark spectrum has already been taken. It is stored in the device and automatically subtracted from the measured spectrum each time you take a new spectrum.

To recalibrate the dark spectra, simply close the spectrometer entrance, make sure that no light enters the device and choose “Calibrate Dark Spectrum” from the Tools menu. Then click the “Take” button. You can check the new dark spectra by clicking on the “Test Button”. While the test is running, you can see the spectra taken without (red) and with (green) dark spectrum correction in the lower diagram. In the upper diagram you can see the noise level, also without (red) and with (green) dark spectrum correction for a series of exposure times. You can see that the noise level of the raw data (red) increases significantly with increasing exposure time. With dark spectrum correction (green) however, the noise level should remain pretty much at the same level for exposure times less than 1 second and increase slower for exposure times larger than 1 second. If you find this to be the case, close the window by clicking on the “OK” button and the new
dark spectrum calibration is saved into the device. Otherwise you may calibrate again or click “Cancel”.

Spectral Sensitivity

Like in all spectrometers, the sensitivity of the Qmini spectrometer is not uniform across the spectrum, but depends on the wavelength. This is called “Spectral Sensitivity” and can be corrected by dividing each value of the spectrum by the corresponding sensitivity. This sensitivity calibration is also stored in the device. However, it is not always used when taking spectra, because if the sensitivity is corrected, the noise level is unevenly distributed across the spectrum. Instead, you can choose to use the spectral sensitivity correction by selecting the “lightmeter” button in the Exposure Toolbar.

If you would like to recalibrate the spectral sensitivity, you need a light source with a continuous spectrum (like a tungsten halogen lamp) and a spectrum file containing the actual spectrum for this lamp.

To recalibrate, choose “Calibrate Spectral Sensitivity” from the Tools menu. Connect your light source to the spectrometer and click on “Take Spectrum”. When the spectrum is taken, click on the “Load reference data” button to load the calibrated reference spectrum (in other words: a spectrum file that shows how your light source really looks like). Based on the measured spectrum and this file, the software calculated the spectral sensitivity of your spectrometer and shows it as a dark green line. To save this new calibration to the device, click “OK”. You can also enter the physical unit of the y-axis of the corrected spectra and a description.

If you also want to calibrate the absolute scale of the intensity axis, you need to take a spectrum and also need to know the absolute optical power (in Watts) of this spectrum. If you measure the actual optical power with an optical powermeter, please make sure that the powermeter only detects wavelengths that are within the wavelength range of your spectrometer (for example by choosing a suitable light source). Then choose “Calibrate power” from the Tools menu and enter the actual power. If you click “OK”, the new power calibration is stored in the device and used for scaling the intensity axis. This axis then displays the spectral power density in the physical unit specified in the “Calibrate Spectral Sensitivity” window.

In addition, you can calibrate the power not just with respect to the spectrometer entrance, but also to any other point in your optical setup. For instance, you could calibrate the power that enters your measurement probe or any other power in your setup, as long as it is proportional to the power that enters the spectrometer. Just remember that the optical powers and power densities displayed by the software refer to this value.

Nonlinearity

In an ideal spectrometer the measured spectrum would be exactly proportional to the incoming light intensity. All real spectrometers, however, exhibit certain nonlinear
deviations. For example, this means that if you reduce the light intensity by one half, you may not get exactly half the measured spectrum. Fortunately, this nonlinearity can be well described by a polynomial function and corrected in software.

The nonlinearity of each Qmini spectrometer is calibrated during production and automatically corrected. This calibration hardly changes with time or temperature, so in most cases you don’t need to worry about it.

However, if you would like to check or recalibrate the nonlinearity calibration, please open the “Calibrate Nonlinearity” window. You need a stable broadband light source with a smooth spectrum, like a tungsten or LED lamp. Connect the lamp and click on “Take” to recalibrate the nonlinearity or “Test” to check it.

3.11 Triggering and I/O Port

Trigger Options

Spectra are generally taken after you click on one of the green buttons (▶ or ▶) in the Exposure Toolbar. In addition, you can set the spectrometer to wait for an additional event before taking a spectrum. This is called “Triggering”. In the Exposure Toolbar, you can select one of three different trigger modes:

- **continuous**: Spectra are taken as soon as possible.
- **interval**: Spectra are taken in regular time intervals. You can specify the time between two spectra and also a time period after which the measurement is stopped. The timer progress is shown in the status bar. Obviously, this trigger mode does not apply to single shot measurements.
- **external**: Spectra are taken after the input voltage on one of the external I/O channels has changed. You can use this to synchronize the exposure to other devices or external events.

In the “Device Configuration” window you can select further trigger options. These trigger options apply to the external as well as to the internal (continuous and interval) trigger modes.

- **Trigger on end of exposure**: This is the default mode. The spectrometer is continuously taking spectra and when the trigger event occurs, the current spectrum is read out. This causes a random trigger delay between zero and the exposure time.
- **Trigger on start of exposure**: The spectrometer is continuously taking spectra and when the trigger event occurs, the next spectrum after the one currently being taken is read out. Choose this mode if you need to make sure that no light is collected for the spectrum before the trigger event occurs or before you click the button. This mode requires more time to take a spectrum. It also causes a random trigger delay between zero and the exposure time.
- **Hardware triggered (low-jitter) mode**: The spectrometer is continuously taking spectra with a very short exposure time of 50 μs and when the trigger event occurs, a new spectrum is started with the selected exposure time. This causes a trigger delay of less than 50 μs. However, in this mode the accuracy of the intensity values is reduced. Therefore, only use low-jitter mode if your application really requires it. In this mode the CCD sensor has different dark signal properties. Therefore, when turning low-jitter mode on or off, it is recommended to take a new set of dark spectra.

The hardware triggered mode is not implemented yet in version 2.0.1 of the Qmini device firmware. Please contact us if you need a firmware update.

For external triggering, there are a few more options described below.

**I/O Channels**

The new Qmini includes a new auxiliary connector for analog and digital I/O, communication interfaces and power supply (if USB is not used). Four of the digital channels can be configured as trigger input, shutter or flash lamp control, process control or general purpose I/O pins. You can configure the channels in the “Device Configuration” window. Please see chapter 6 for the pin assignment of the external connector.

In order to use a channel as an external trigger source, please:

- Set this pin to “Input”
- Set the trigger pin number
- Select either Falling Edge (trigger occurs when the input voltage drops from 3.3 to 0 V) or Rising Edge (trigger occurs when the voltage rises from 0 to 3.3 V).
4  Software Development Kit

The CD-ROM includes a Software Development Kit (SDK) for the spectrometer that can be used to control it and take spectra from your own custom software. It includes a Windows Dynamic Link Library (DLL) for the .NET framework, documentation and sample code.

Alternatively, you can also directly communicate with the spectrometer from your own software including embedded systems. Please see the separate Communication Protocol Manual for more details.

4.1  Prerequisites

The system requirements for the SDK are the same as for Waves (see chapter 1.2).

You can use the SDK with any programming language that can connect to .NET DLLs. This includes C#, Visual Basic .NET, C++/CLI, Delphi, LabView, Matlab and Mathematica. You should have a basic understanding of the concepts of object-oriented programming in order to understand the structure and functionality of the SDK library. The SDK includes sample code that demonstrates how to access the DLL from LabView, Matlab, C#, C++ and using COM.

4.2  Getting started

In order to get familiar with the SDK quickly, we suggest to:

1.  Read the next chapter 4.3 to understand the structure of the SDK library.
2.  Read the basic steps required in order to take a spectrum (chapter 4.5).
3.  Study the sample projects included in the SDK.
4.  Add the SDK library to your own project (chapter 4.4).
5.  Implement the basic functionality of taking a spectrum in your project.
6.  Implement advanced features as required.

4.3  Classes Overview

The SDK library contains classes for controlling a spectrometer or laser as well as abstract base classes for various types of measurement and control devices.

The main class that you need in order to communicate with the spectrometer is: Qseries
   which is a descendant of the CalibratedSpectrometer class,
   which is a descendant of the Spectrometer class,
   which is a descendant of the Device class.
The Device class includes basic features used by all kinds of measurement and control devices. Spectrometer is a base class for a simple spectrometer. CalibratedSpectrometer is a base class for a spectrometer that supports pre-processing of the spectra. Qseries implements all the features specified in the abstract base classes in order to control a Qmini spectrometer.

The library also includes the SimulatedSpectrometer class, that may be used instead of Qseries to test your software in case you don’t have a real device available, just like choosing “Simulated Spectrometer” in Waves.

You can find the full documentation for all relevant classes in the SDK documentation contained in the RgbDriverKit documentation.chm help file.

### 4.4 Adding the SDK library to your project

The library to connect to your spectrometer is in the RgbDriverKit.dll file. Please copy it to your main project folder. The device driver for Windows must also be present.

**Visual Studio**

If you are using one of Microsoft’s languages, please add the library in Visual Studio to your project references (in the Solution Explorer window). Then import the RgbDriverKit library to your source code files (for example in C# or C++: “using RgbDriverKit;”). For enhanced IntelliSense support in Visual Studio, you may also want to copy the RgbDriverKit.xml file into the same folder as the library.

**LabVIEW**

In order to use a .NET DLL in LabVIEW, you need to:

- Use the .NET palette (Connectivity -> .NET) to find all of the functions available.
- Use a constructor node in order to instantiate a class within the .NET assembly.
- Use property nodes and invoke nodes to access properties and methods of the class by wiring in the class reference from the constructor node to the property or invoke node.

Specific LabVIEW VIs for controlling the Qwave spectrometer are planned for a later release of the SDK.

**Other languages**

For more information on how to connect to the library from other programming languages, please try a Google search for something like “use .NET DLL in [your language]”.

---

21
4.5 Taking a spectrum

First you need to instantiate a Qseries object to control your spectrometer. You could use the class constructor, of course, but in most cases it’ll be easier to search for spectrometers by calling the static SearchDevices() method and then choose from one of the returned objects, which are actual instances of the Qseries class.

Then, the steps required for taking a simple spectrum are:

1. Open the connection to the device using the Open() method.
2. If you need the wavelengths, get an array containing the wavelengths of each pixel with GetWavelengths().
3. Set the exposure time using the ExposureTime property.
4. Start the exposure with the StartExposure() method.
5. Wait (or do something else) while the Status property is SpectrometerStatus.TakingSpectrum.
6. Read the spectrum with the GetData() method.

The full documentation for these methods and properties can be found in the RgbDriverKit documentation.chm help file.

All methods and some properties may throw an exception as described in the SDK documentation help file. Always make sure that these exceptions are properly handled by placing these methods inside a try{} catch{} block.

4.6 Deploying your project

If you would like to deploy your project to other users, please:

- Include the DLL file RgbDriverKit.dll.
- Make sure that the .NET framework 3.5 or 4.0 is installed.
- Make sure that the Windows device driver is installed.

The device driver is normally installed during the installation of Waves. If you would like to use the spectrometer without installing Waves, you can find the files for the device driver in the “WinUSB driver” folder in the SDK.
5 Technical Support

5.1 Getting Help

If you have any questions, comments or requests concerning your Qmini spectrometer or the Waves software, please go to http://www.rgb-photonics.com and click on “Support” on the menu bar.

There you’ll also find details on how to contact our Technical Support Team via e-mail or telephone.

5.2 Software Updates

Software Updates are expected to be released about twice a year. To check for updates, you can choose “Check for Updates” from the Help menu or go to the “Support” section on our website www.rgb-photonics.com.
6 Specifications

Optical

- Focal length: 50 mm
- Numerical Aperture: 0.1
- Grating: 300 or 600 lines/mm
- Entrance slit: 20 μm (can be changed by user)
- Spectral resolution (FWHM): ≥ 0.3 nm
- Stray light: < 0.1 %
- Optical interface: SMA connector

Electronic

- Dynamic range: 500 : 1 (full scale, \( t_{\text{exp}} = 1 \) s)
- Detector: 2500 pixel linear CCD detector
- A/D converter: 16 bit
- Calibration: Wavelength, sensitivity and dark spectrum stored within device
- Digital Interfaces: USB 2.0 with Type-C connector, UART (serial), SPI, PC
- Extension port: 4 General purpose I/O channels
  - Configurable as trigger input
  - Digital interface for accessories
- Power supply: 5 V DC via USB (no power adapter required)
- Power consumption: up to 130 mA
- PC operating system: Windows 10, 8, 7, Vista, XP

Mechanical

- Dimensions: 64.0 × 42.0 × 14.5 mm
- Weight: 60 g
- Operating temperature: -15°C to 60°C (non-condensing)
- Storage temperature: -25°C to 70°C
Technical Drawing

All dimensions in mm. 3D CAD files are available for download.
6.2 Pin Assignment

Auxiliary Interface

The 30-pin auxiliary connector on the front side of the spectrometer is a Samtec TFM-115-02-L-D-WT. You can either obtain the optional I/O port adapter for the Qmini or design your own accessory. Please note: The notch in the upper right corner of the connector does NOT indicate the position of pin 1.

Compatible Samtec mating connectors include:

- SMT right-angle: SFM-115-02-L-DH-TR
- SMT straight: SFM-115-02-S-D-LC
- SMT straight: SFMC-115-02-L-D (no alignment)
- SMT straight: SFMC-115-L2-L-D (no alignment, Low Insertion Force)
- SMT straight: SFM-115-L2-S-D-SN
- Through-Hole: SFMC-115-[xx]-L-D- (SMT)
- Wires: ISDF-15-D-M + CC03R-2830-01-G

Please see below for a description of all interface pins. Don’t hesitate to contact us if you need further information about the auxiliary interface.

All logic levels are 0 V / 3.3 V (except power supply and USB). Therefore please do not connect any interface pin directly to the 5 V power supply.
## Specifications

<table>
<thead>
<tr>
<th>Pin number</th>
<th>Signal name</th>
<th>Alternative function</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V_AUX_IN</td>
<td>-</td>
<td>PWR</td>
<td>Power Input</td>
</tr>
<tr>
<td>2</td>
<td>USB_DN</td>
<td>-</td>
<td>IO</td>
<td>USB bidirectional D-line</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>-</td>
<td>PWR</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>USB_DP</td>
<td>-</td>
<td>IO</td>
<td>USB bidirectional D+ line</td>
</tr>
<tr>
<td>5</td>
<td>VBUS</td>
<td>-</td>
<td>I</td>
<td>VBUS pin (power on USB cable)</td>
</tr>
<tr>
<td>6</td>
<td>UART_RXD</td>
<td>GPIO</td>
<td>I</td>
<td>Receiver input for UART</td>
</tr>
<tr>
<td>7</td>
<td>UART_TXD</td>
<td>GPIO</td>
<td>O</td>
<td>Transmitter output for UART</td>
</tr>
<tr>
<td>8</td>
<td>UART_CTS</td>
<td>GPIO</td>
<td>I</td>
<td>Clear to Send input for UART</td>
</tr>
<tr>
<td>9</td>
<td>UART_RTS</td>
<td>GPIO</td>
<td>O</td>
<td>Request to Send output for UART</td>
</tr>
<tr>
<td>10</td>
<td>GND</td>
<td>-</td>
<td>PWR</td>
<td>Ground</td>
</tr>
<tr>
<td>11</td>
<td>SPI_MISO</td>
<td>GPIO</td>
<td>I</td>
<td>Master In Slave Out for SPI</td>
</tr>
<tr>
<td>12</td>
<td>SPI_CS</td>
<td>GPIO</td>
<td>O</td>
<td>Slave Select for SPI</td>
</tr>
<tr>
<td>13</td>
<td>SPI_SCK</td>
<td>GPIO</td>
<td>O</td>
<td>Serial clock for SPI</td>
</tr>
<tr>
<td>14</td>
<td>SPI_MOSI</td>
<td>GPIO</td>
<td>O</td>
<td>Master Out Slave In for SPI</td>
</tr>
<tr>
<td>15</td>
<td>GND</td>
<td>-</td>
<td>PWR</td>
<td>Ground</td>
</tr>
<tr>
<td>16</td>
<td>RESENTn</td>
<td>-</td>
<td>I</td>
<td>Reset is low active (to reset device keep low for &gt;1 ms)</td>
</tr>
<tr>
<td>17</td>
<td>TRIG_IO_0</td>
<td>GPIO / PWM</td>
<td>IO</td>
<td>low latency trigger input/output</td>
</tr>
<tr>
<td>18</td>
<td>TRIG_IO_1</td>
<td>GPIO / PWM</td>
<td>IO</td>
<td>low latency trigger input/output</td>
</tr>
<tr>
<td>19</td>
<td>TRIG_IO_2</td>
<td>GPIO / PWM</td>
<td>IO</td>
<td>low latency trigger input/output</td>
</tr>
<tr>
<td>20</td>
<td>TRIG_IO_3</td>
<td>GPIO / PWM</td>
<td>IO</td>
<td>low latency trigger input/output</td>
</tr>
<tr>
<td>21</td>
<td>GND</td>
<td>-</td>
<td>PWR</td>
<td>Ground</td>
</tr>
<tr>
<td>22</td>
<td>I2C_SCL</td>
<td>GPIO</td>
<td>IO</td>
<td>I2C clock input/output</td>
</tr>
<tr>
<td>23</td>
<td>I2C_SDA</td>
<td>GPIO</td>
<td>IO</td>
<td>I2C data input/output</td>
</tr>
<tr>
<td>24</td>
<td>CAN_TD</td>
<td>GPIO</td>
<td>O</td>
<td>CAN transmitter output</td>
</tr>
<tr>
<td>25</td>
<td>CAN_RD</td>
<td>GPIO</td>
<td>I</td>
<td>CAN receiver input</td>
</tr>
<tr>
<td>26</td>
<td>GND</td>
<td>-</td>
<td>PWR</td>
<td>Ground</td>
</tr>
<tr>
<td>27</td>
<td>DAC</td>
<td>-</td>
<td>O</td>
<td>10-bit Digital-to-Analog Converter</td>
</tr>
<tr>
<td>28</td>
<td>ADC</td>
<td>-</td>
<td>I</td>
<td>10-bit Analog-to-Digital Converter</td>
</tr>
<tr>
<td>29</td>
<td>GND</td>
<td>-</td>
<td>PWR</td>
<td>Ground</td>
</tr>
<tr>
<td>30</td>
<td>+5V_AUX_OUT</td>
<td>-</td>
<td>PWR</td>
<td>Power Output (300 mA max.)</td>
</tr>
</tbody>
</table>
7 Certifications and Compliance

CE Declaration of Conformity

The manufacturer

RGB Lasersysteme GmbH
Donaupark 13
93309 Kelheim

declares that the following product

Qmini Version 2.0

complies with the following normative documents

EN61000-6-4: 2007 + A1:2011
EN61000-6-2: 2005

and therefore with the following EG requirements

Electromagnetic compatibility (2014/30/EU)

This declaration applies to all models of the above named product version, in case it will be used in the configuration of the test assembly.

Kelheim, October 06th, 2016

Mathias Reichl
RoHS Declaration of Conformity

The manufacturer

RGB Lasersysteme GmbH
Donaupark 13
93309 Kelheim

declares that the following product

Qmini Version 2.0

contains no toxic substances which are specified in the

RoHS Directive 2011/65/EU.

The conformity to RoHS Directive 2011/65/EU is confirmed.

This declaration applies to all models of the above named product version.

Kelheim, October 06th, 2016            Mathias Reichl